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They are used to position, hold, protect and organize components and sub-
assemblies at all stages of the manufacturing process. And although these tools 
are virtually invisible when production is running smoothly, their importance 
becomes evident when problems arise. To avoid production halts or product 
defects, new manufacturing tools must be rapidly designed, manufactured  
and deployed. 

Jigs and fixtures are most commonly fabricated from metal, wood or plastic in 
quantities of one to 100 using a manual or semi-automated process. Elaborate or 
intricate tools may require several cycles of design, prototyping and evaluation to 
attain the required performance. On average, each tool takes between one and 
four weeks to design and build.

By substituting Fused Deposition Modeling™ (FDM®), the traditional fabrication 
process is substantially simplified; tool-making becomes less expensive and 
time consuming. As a result, manufacturers realize improvements in productivity, 
efficiency and quality. Additionally, these tools can be designed for optimal 
performance and ergonomics as FDM places fewer constraints on  
tool configuration.
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1. Overview

1.1. Application:

FDM is an alternative fabrication method for the construction of jigs, 
fixtures and related tools used in departments such as:

•	Engineering

-- Research & development
-- Product development
-- Life cycle
-- Compliance

•	Manufacturing

-- Assembly
-- Molding
-- Machining
-- Casting

•	Inventory / Inspection

-- First Article
-- Mid-line testing
-- End-of-line testing
-- Organization

•	Field service

These departments use various types of jigs and fixtures including:

•	5S organizational aids

•	Assembly fixtures

•	Weldment fixtures

•	Drill or trim guides

•	Marking templates

•	Masking tools

•	Alignment jigs

•	Clamping/holding fixtures

•	Robotic arm end-effectors/tools

•	Inspection fixtures

•	Transportation trays

•	Part nesting trays

1.2. FDM is a best fit when:

•	Tool is small to moderately sized.

-- Ideal, but smaller or larger are possible:
•	XYZ = 13 mm (0.5 in)

•	XYZ = 300 mm (12.0 in)

•	Quantities are small.

-- Production quantities are between 1 – 100+.
-- Acceptable quantities can vary based on tool size.

•	For larger quantities, consider using an FDM part as a pattern 
for duplication.

Figure 1: BMW badge alignment fixture.

Figure 2: Assembly, test and inspection fixtures.

Figure 3: FDM 5S organizational tray with label and cover.

Figure 4: Articulating screw alignment fixture (PC-white).
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•	Materials are compatible.

-- Confirm suitability of thermoplastic materials to ensure:
•	Mechanical and electrical properties

•	Chemical resistance and thermal resistance

•	Accuracy is suitable.

-- Parts are easily capable of achieving +/- 0.13 mm (0.005 in).
•	In certain cases, FDM can still be a viable option for high tolerance 

parts by using a secondary machining operation to improve accuracy 
of critical dimensions.

•	Deployment is limited.

-- Use for applications where time, cost and effort have previously 
exceeded the operational value.

•	Replacement or revision rate is frequent.

-- Process efficiency and speed are ideal for tools with short 
life expectancies.

•	New operations or processes are being implemented.

-- Use when building out a production line for a new product or 
when overhauling an existing line.

1.3. Successful adopter traits (first iteration and long-term):

•	Change design and manufacturing process to fit new  
production technology.

-- Tool design for FDM
-- Fabrication process and approach  
(i.e.,consolidated components)

•	FDM is a fitting alternative to traditional manufacturing.

-- FDM performance characteristics meet or exceed requirements.
-- FDM applied to overlooked operations (i.e., those where a “nice-
to-have” tool has not been made).

•	Start simple, then advance.

-- Tackle straightforward applications first.
-- With experience, move on to more  
demanding tools.

•	Design for performance, time and cost.

-- Start with a fresh design that optimizes tool qualities as well as 
FDM build time and material consumption.

Figure 5: CMM inspection fixture.
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1.4. FDM Adoption Obstacles:

1.5. Benefits:

•	Lead time reduction

-- Average lead time savings: 40% to 90%
•	Cost reduction

-- Average cost savings: 70% to 95%
•	Efficiency gains

-- Streamline and improve jig/fixture making.
•	Eliminate detailed drawings.

•	Minimize paperwork.

•	Design freedom

-- Improve performance.
•	Maximize ergonomics.

•	Integrate sensors, RFID tags and hardware.

•	Consolidate multi-piece assemblies.

2. Design for Function (CAD)
A common way to apply FDM Technology™ to jig and fixture construction is to 
use existing designs and design rules. However, they may not capitalize on the 
advantages of FDM. In fact, they may negatively affect performance, time  
and cost.

Whenever possible, leverage the design freedoms offered by the  
additive process.

2.1. Integrated design (consolidation) (*)

Convert assemblies into a single part. Often, jigs and fixtures are dissected 
into many pieces to make conventional manufacturing processes feasible 
and affordable (Figures 6 and 7). This is unnecessary with FDM.

Obstacle Solution*

Adhering to traditional  
design practices.

•	 Optimize part design for FDM as outlined in FDM  

Design Handbook.

Making (large, bulky)  
tools is time consuming 
and expensive.

•	 Reduce time and material with sparse fills and large rasters.

•	 Reduce time by making supports from model material.

•	 Use evenings and weekends for long builds.

Processing files with  
default parameters.

•	 Use Insight software to adjust strength, porosity, surface quality 

and weight.

Operation has high 
mechanical  
loads or wear.

•	 Confirm that thermoplastic is suitable.

•	 Improve mechanical properties with Insight software tools.

•	 Improve mechanical properties by designing for the FDM process.

•	 Mount or embed a secondary component to compensate.

Applying FDM to  
high-precision applications.

•	 Offset surfaces in CAD.

•	 Orient critical dimensions in XY plane.

•	 Use secondary machining.

* Additional solutions may exist.

Figure 6: Assembly drawing illustrating components of 
conventionally manufactured badge alignment fixture.

Figure 7: Machined metal fixture made of over two
dozen parts.

Figure 8: Redesigned FDM fixture consolidates most
components and is optimized for ergonomics.

TECHNICAL APPLICATION GUIDE  /  5

FDM FOR JIGS AND FIXTURES



If reproducing an existing tool, integrate as many components as possible 
into one piece (Figure 8). If designing a new item, create it as one piece. 
Only split off parts when it is advantageous to the operation of the jig  
or fixture. 

Integrated design has many advantages including:

•	Improved functionality.

-- Focus on the task that the tool will perform. Optimize its design 
for function rather than the process used to make it.

•	Elimination of tolerance challenges.

-- Holding tight tolerances is costly. If two mating parts are 
combined into one, concerns related to controlling the tolerances  
are eliminated.

•	Elimination of assembly time.

-- Assemblies, obviously, must be assembled and this takes time. 
And for one-off items like jigs and fixtures, perfect fits are not 
guaranteed. Consolidate all parts into a single piece to eliminate 
time need for assembly.

2.2. Ergonomic design (*)

For any hand-operated tool (Figure 9), or those that are frequently moved 
between work areas, ergonomic design is quite important. The weight, 
balance and position of the tool have direct effects on:

•	Technician comfort

•	Process cycle time

•	Ease of access and storage

When designing new jigs and fixtures, or redesigning old ones, incorporate 
ergonomics into the configuration. There will be little or no change in the 
cost and time to produce a lightweight, well-balanced, easy-to-handle tool 
(Figure 10).

2.3. Integrated features (*)

There are two aspects to integrated features: adding features and  
inserting hardware.

2.3.1. Adding features.

With traditional manufacturing processes, there is usually a 
cost associated with every feature. This is not true with additive 
manufacturing, especially when material is removed.

In the design of an FDM tool, consider adding features that improve 
performance, reduce build times and reduce material costs.  
For example:

•	 Add pockets, channels and holes (Figure 11).

-- Removing mass from the jig or fixture will decrease weight, 
material consumption and build time. This is an especially 
important modification for large, bulky tools.

Figure 9: FDM badge alignment fixture is lightweight 
because of its plastic construction and use of sparse fill 
build styles.

Figure 10: Fixture is also well-balanced.

Figure 11: Each arm for a “robotic gripper” has
integrated vacuum channels and generous ribbing.

Figure 12: Embellish tooling with part numbers,
alignment aids and instructions.
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•	 Add embellishments (Figure 12).

-- Incorporate part numbers, storage locations, alignment 
aids, logo, or operational instructions directly on the tool.

2.3.2. Adding hardware.

As with traditional manufacturing, hardware may be added in a 
secondary operation (Figure 13). For example, threaded inserts can 
be press-fit into location holes added to the CAD model or machined 
after the FDM tool has been built.

An alternative is to mimic insert molding. In the CAD model, add 
a pocket or hole that will contain a sensor, RFID tag, bushing or 
threaded insert. During the FDM build process, pause the job, place 
the item in the part and resume the build. The hardware is now 
integrated within the FDM tool (Figures 14 and 15).

2.4. Optimize FDM performance

CAD design may also be used to improve dimensional accuracy and 
strength while further decreasing build times.

2.4.1. Adjust features.

•	 Offset surfaces. 
 
For high-precision features, consider building a sample jig or 
fixture and inspecting it for adherence to requirements. Make 
design adjustments as needed.

-- Build and measure a sample tool.
-- Calculate the required adjustment.
-- Where oversized, offset the feature’s surfaces inward. 

Where undersized, offset the feature’s surfaces outward 
(Figure 16).

•	 Adjust wall thicknesses. 
 
Interior gaps may result if the thickness is not evenly divisible by 
the contour width of the FDM toolpath. These may be eliminated 
through custom groups (see Section 4.3.). In the software or by 
adjusting the wall thickness in CAD.

-- After determining the build material and slice height 
(Section 3.2.), review the available contour widths 
(Toolpaths> Setup > Advanced parameters).

-- Select the desired contour width.
-- Adjust the feature thickness to equal an even number of 

contours. For example, if the contour is 0.51 mm (0.020 in), 
make the thickness 0.10 mm or 0.20 mm (0.040 in or 0.080 
in) (Figure 17).

•	 Eliminate tapered walls. 
 
Features that taper in the Z axis will have wall thicknesses that 
vary by elevation. This prevents wall thickness adjustment to 
match contour thickness for elimination of interior gaps. Where 
possible, make all surfaces perpendicular to the XY plane when 

Figure 13: Add hardware, such as this metal sleeve, in 
secondary operations.

Figure 14: Integrate hardware, such as this center
bushing, during FDM builds.

Figure 15: Clamping device uses both integrated
hardware and secondary add-ons.

Figure 16: Offset surface for improved precision.

Figure 17: Create walls with an even number of contours.
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it is oriented in its build position (Figure 18).

•	 Eliminate supports.

•	 Supports are added to the bottom of a part and to all features 
with an angle, as measured from the XY plane, that are less 
than the self-supporting angles in the software. Since supports 
increase build times and material expense, it is advantageous to 
minimize them. One option to do so is to modify the  
CAD model.

-- Identity features. 
 
The default self-supporting angle ranges from 40° to 45°. 
Review the model to identify any features that are near this 
angle and can be modified. 

-- Adjust features. 
 
Alter the design of the identified features by increasing the 
angle so that it is > 45° from the XY plane (Figure 19). For 
features less than 6.3 mm (0.25 in) wide in the XY plane, a 
cylindrical profile may be used.  
 
Alternatively, the self-supporting angle may be adjusted in 
the software (Support > Setup > Support parameters). In 
general, a 3° adjustment is safe.

2.5. Design iterations (*)

This design consideration is more of a reminder than a design technique. 
View each build as a prototype. Continue to revise the design to optimize 
its performance (Figures 20, 21, 22).

Because FDM works directly from the CAD data, it is both quick and 
economical to build FDM tools. It is quite practical to gather feedback 
from the first iteration and make adjustments because of the speed of the 
process and the elimination of overhead (e.g., detail drawings or purchase 
order approval). With a simple adjustment of the CAD model and few 
minutes in the software to prepare the job, a new revision is ready to build.

2.6. Variable density (***)

A unique characteristic of FDM is that a single part can have regions with 
different build styles. The advantages of this characteristic include varying 
density for:

•	 Optimal strength and weight.

•	 Optimal time and cost.

To some degree, this can be achieved in the software by using custom 
groups. For advanced control, changes are made to the CAD model so 
that each region is processed with different toolpath options.

2.6.1. Modify CAD model.

2.6.1.1. Create CAD model of tool (Figure 23).

Begin with a complete CAD model of the tool. Next, place 

Figure 18: Eliminate tapers.

Figure 19: Create self-supporting features.

Figure 20: Revision 1 – CMM inspection fixture –
original design.

Figure 21: Revision 2 – material removed to decrease time 
and cost.

Figure 22: Revision 3 – complete redesign for function, 
throughput and expense.
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the model in the same orientation in which it will be built.

To assist with alignment in Insight, add a reference feature. 
Locate this feature at the origin (0, 0, 0) and make it slightly 
taller than the tool. 

Save the model.

2.6.1.2. Extract first region (Figure 24).

Extract the first variable density region from the CAD model 
and delete the balance.

Note: The reference feature must be retained.

Export this file as a high resolution STL.

2.6.1.3. Extract second region (Figure 25).

Open the original CAD file and extract the next region. As 
with the first, retain the reference feature while deleting the 
balance of the model.

Since Insight software will combine curves that appear to 
overlap, adjust this region by offsetting all surfaces that 
coincide with the first region. A surface offset of 0.03 mm 
(0.001 in) will suffice.

Export the file as a high resolution STL.

Note: Large facets can create regions of overlapping curves 
between parts. This can create problems during toolpath 
generation. To avoid this problem use small facets and 
visually inspect all layers after toolpath generation in  
the software.

Repeat this step for all other regions of the tool.

2.6.2. Process regions in Insight software.

2.6.2.1. Process first region.

Open the STL file for the first region (Figure 26). Select the 
model material and slice height. Then, orient and slice the 
file. Confirm that the reference feature is located at the origin 
to ensure that all regions will be aligned.

Next, apply toolpath settings to achieve the desired 
characteristics for the region. For example, change the part 
interior style to “Sparse-double dense” (Figure 27) through 
custom groups (Toolpaths > Custom groups > Add).

Now, save the job (File > Save as > Job).

2.6.2.3. Process last region.

Open, orient and slice the last STL file (Figure 28) and apply 

Figure 24: Region one (transparent-yellow outer area) and 
region two (opaque center).

Figure 23: Original CAD model of robot gripper arm with 
reference feature at 0,0,0.

Figure 25: CAD model of region two with reference feature.

Figure 26:Open first region in Insight and apply
toolpaths using custom groups.

Figure 27: First region has a Sparse – double dense fill.
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the desired toolpaths by using custom 
groups (Figure 29).

Save the job and keep the file open (File 
> Save as > Job. Next, add the previous 
regions (Slice > Combine slice curve files). 
The reference feature will force all regions 
to align to each other (Figure 30).

After all regions have been added, 
select and delete the curves for all of 
the reference features (Edit > Delete > 
Curves).

Save the job and continue with the usual 
file preparation procedures (File > Save  
as > Job).

3. Selections: Material and Slice
Jigs and fixtures have performance requirements that 
are tied to the material from which they are made. When 
producing jigs and fixtures with FDM, spend a few minutes 
to consider the options for materials and slice heights. 
These are the first selections made when processing parts in 
Insight; they are fundamental to the tool’s performance, as 
well as the efficiency of the operation.

Start with your material decision (Figure 33). Then, move on 
to slice height selection.

3.1. Material selection (*)

The following are three key selection criteria:

•	Material properties (Figure 34) 
 
Consider the operational demands for the tool 
in terms of mechanical, thermal, chemical and 
electrical properties.

•	Support material 
 
FDM offers two support styles: breakaway and 
soluble. The material selection will dictate which 
styles are available so consider if the advantages 
of soluble supports (e.g. automated, labor-free and 
fewer concerns over access) are required. If so, 
choose a material that offers the appropriate type 
of support. (Table 1).

•	Slice height (Figure 35) 
 
Materials also determine which slice heights are 
available (Table 1). Slice height affects surface 

Figure 28: Open and slice the second region. Figure 29: Fill style for the second region  
is solid.

Figure 30: Combine both regions and process 
for building.

Figure 31: Above and below the mid-line, the 
result is a solid fill where strength is needed.

Figure 32: At the mid-line, a solid wall 
surrounds the vacuum channel.

Figure 33: Select materials first and then 
select slice height.

Mechanical 
Properties

English Metric

Tensile Strength 5,200 psi 36 MPa

Tensile Modulus 350,000 psi 2,413 MPa

Tensile Elongation 4% 4%

Flexural Strength 8,800 psi 61 MPa

Flexural Modulus 336,000 psi 2,317 MPa

IZOD Impact, notched 2.6 ft-lb/in 139 J/m

IZOD Impact, un-notched 5.3 ft-lb/in 283 J/m

Figure 34: Review FDM material data sheets to find the desired properties. (Build orientation is on 
long side.)

Figure 35: Slice height selection establishes 
which tips to use.

FDM FOR JIGS AND FIXTURES
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smoothness and specifies available raster and contour widths (see 
Section 3.2).

3.2. Slice selection (*)

Table 1 lists the available slice heights for each of the FDM materials. Slice 
height specifies the vertical thickness of each layer, which in turn, affects 
surface resolution and stairstepping. It also determines which extrusion tip 
to use, which in turn, dictates the range of raster and contour widths  
(Table 2).

Important: Slice selection influences build time, surface quality, feature 
resolution and part strength. Therefore, take into account each of  
these factors:

Thinner slices (Figure 36):

•	Thinner layers = smoother surfaces

FDM Material Support Style Slice Heights mm (in)

ABSplus Breakaway or Soluble 0.127 (0.005)**

0.176 (0.007)

0.254 (0.010)

ABSi Soluble 0.127 (0.005)**

0.176 (0.007)

0.254 (0.010)

0.330 (0.013)

ABS-M30 Soluble 127 (0.005)**

0.176 (0.007)

0.254 (0.010)

0.330 (0.013)

ABS-M30i Soluble 0.127 (0.005)**

0.176 (0.007)

0.254 (0.010)

0.330 (0.013)

ABS-ESD7 Soluble 0.176 (0.007)

0.254 (0.010)

PC-ABS Soluble 0.127 (0.005)**

0.176 (0.007)

0.254 (0.010)

0.330 (0.013)

PC Breakaway or Soluble 0.127 (0.005)* / **

0.176 (0.007)

0.254 (0.010)

0.330 (0.013)

PC-ISO Breakaway 0.176 (0.007)

0.254 (0.010)

0.330 (0.013)

PPSF Breakaway 0.254 (0.010)

0.330 (0.013)**

ULTEM™ 9085 thermoplastic resin Breakaway 0.254 (0.010)

0.330 (0.013)***

Table 1: FDM material options.
* Soluble only
** Fortus® production system 400mc only
*** Fortus® production system 900mc only

Figure 36: Select thinner slices for small features, smooth 
surfaces and dense fills.

Figure 37: Select a thicker slice resolution for wider
rasters and faster builds.

Figure 38: Default orientation when yoke fixture is opened in 
Insight software.
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•	More layers = increased build time

•	Narrow toolpaths (rasters and contours) =

-- Finer feature resolution
-- Denser fills for thin walls

Thicker slices (Figure 37):

•	Thicker layers = faster builds

•	Fewer layers = increased stairstepping

•	Wider toolpaths (rasters and contours):

-- Faster deposition and shorter builds Stronger parts

4. File Processing (Insight)
Although Insight software’s “green flag” defaults will produce acceptable, and 
usually very good results, there are many control options to consider. These 
options apply to both the model and the support, and are used to improve 
part quality and process throughput. The following file processing actions are 
commonly used to improve jig and fixture designs while maximizing  
process speed.

4.1. Part orientation (*)

Part orientation is one of the few required actions for every part. Whether 
using default toolpath parameters or customizing toolpaths manually, it 
is the first step. Although orienting to minimize the Z-height, and possibly 
build time may be a viable strategy, the following are equally important 
considerations (Figures 38 and 39).

4.1.1. Considerations:

•	 Strength (Figure 40)

-- Orient the part so that the forces and loads are 
perpendicular to the slices.

•	 Surface finish

-- Orient the part so that the part’s critical contours are in  
the XY plane.

•	 Accuracy

-- Orient the part so that critical features are in the XY plane.

Slice Height Tip Minimum Toolpath mm (in) Maximum Toolpath mm (in)

0.127 (0.005) T10 0.20 (0.008) 0.58 (0.022)

0.176 (0.007) T12 0.30 (0.012) 0.73 (0.028)

*PC & PC-ISO T12 0.25 (0.010) 0.68 (0.026)

0.254 (0.010) T16 0.41 (0.016) 0.83 (0.032)

*PC-ABS & PC-ISO T16 0.41 (0.016) 0.88 (0.034)

*PPSF & ULTEM T16 0.41 (0.016) 0.78 (0.030)

0.330 (0.013) T20 0.46 (0.018) 0.98 (0.038)

Table 2: Slice height variables.
*Material configured for individual toolpath settings.

Figure 42: In this orientation, more supports are needed.

Figure 41: Orient to minimize layers and volume of supports.

Figure 40: Vertical orientation for greater strength on
stand-offs.

Figure 39: Using orientation tools, rotate fixture 90 degrees.
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•	 Build time (Figures 41 and 42)

-- Orient the part to:
•	Minimize build height.

•	Reduce the volume of support material.

•	Minimize the number of layers that have both model material 
and support material.

4.1.2. Software settings (Figure 43):

There are two recommended options in the software to orient a part.

•	 (STL > Orient by selected facet) 
or

•	 (STL > Rotate)

4.2. Build styles (*)

Insight software offers three interior fill styles: Solid-normal, Sparse, 
and Sparse-double dense. Select the appropriate style for the following 
characteristics:

•	Strength

•	Weight

•	Material consumption

•	Build time

Part interior style may be selected from:

•	(Modeler > Setup) 
or

•	(Toolpaths > Setup)

The following are descriptions and characteristics of the interior fill styles.

4.2.1. Solid-normal (Figure 44)

•	 Dense fill with no gap between adjacent rasters

-- Rasters run perpendicular to those on the preceding layer.
•	 Characteristics:

-- Strongest
-- Heaviest
-- Highest model material consumption
-- Longest build time

4.2.2. Sparse (Figure 45)

•	 Hollow interior with internal lattice for structural rigidity

-- Large air gaps between rasters
-- Uni-directional rasters on each layer (Figure 46)
-- Raster angle alternates between layers

•	 Characteristics:

-- Weakest
-- Lightest
-- Lowest model material consumption

Figure 43: Orientation dropdown menu offering Rotate and 
Orient by selected facet.

Figure 46: Sparse fill alternates raster direction for
each layer.

Figure 44: Fixture with Solid –normal fill.

Figure 45: Fixture with Sparse fill.
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-- Shortest build time
4.2.3. Sparse – double dense (Figure 47)

•	 Hollow interior with internal lattice for structural rigidity

-- Same as Sparse except bi-directional rasters on each layer 
(Figure 48).

•	 Characteristics compared to Sparse Fill:

-- Stronger
-- Slightly heavier
-- Slightly more model material
-- Slightly longer build time

4.2.4. Optimizing sparse fills

For both Sparse and Sparse-double dense, several toolpath 
parameters can be changed to optimize weight, strength and build 
time. Adjustments are made through either:

•	 (Toolpaths > Setup > Toolpath parameters) 
or

•	 (Toolpaths > Custom Groups > New/Modify)

The most frequently changed settings are (Figure 49):

•	 Number of internal contours:

-- Default is the thickness of one contour. Increase the 
number of internal contours to add strength to the surface 
of the part. 
 
Note: The total perimeter thickness will be the “Number 
of internal contours” value plus two default contours. In 
addition to the internal contours, there will be two contours 
on the outside of the part.

•	 Part sparse solid layers: number of slices above and below the 
sparse fill that will have a “Solid-normal” fill style.

-- Increase part sparse solid layers to add strength to the top 
and bottom surfaces.

•	 Part sparse fill air gap: the distance between rasters.

-- Default, which ranges from 1.52 mm to 2.54 mm (0.060 in 
to 0.100 in), is dependent on material and tip size.

-- Increase air gap to reduce build time and material 
consumption.

•	Large values are possible but adjustments may be 
needed for other parameters.

4.3. Custom group for increased strength (*)

Custom groups have many applications. For jigs and fixtures, one of the 
most common uses is to increase the strength of their features.

Using the defaults for Contour style and Contour width across all features 
on an FDM part may result in porosity and air gaps. These voids will 
decrease the strength of features such as thin walls and bosses.  

Figure 47: Fixture with Sparse – double dense fill.

Figure 48: Sparse – double dense fill uses crossing
rasters on each layer.

Figure 49: Advanced parameters for sparse fills
include number of interior contours, solid layers and
size of air gaps.
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For example:

•	Thin wall: A single contour pass may leave an air gap if the distance 
between the contour’s sides is not large enough for a raster fill  
(Figure 50).

•	Boss: At the contact points of the rasters with the contour, the raster 
turnaround will leave a small air gap. If tapping the boss, for example, 
the porosity would be exposed (Figure 51).

Eliminating the voids increases strength. To do this, use custom groups 
to apply user-defined values to the style and width of the outer shell (the 
contours) of individual features. The first approach uses the Multiple 
Contours style.

Procedure:

4.3.1. Create custom group (Toolpaths > Custom groups > New).

Give the custom group a group name and click the checkmark to 
save it.

4.3.2. Calculate contour width.

To eliminate voids in a wall or boss, enter a contour width that is an 
even multiple of the feature’s thickness because all curves must be 
closed. For example, a 2.0 mm (0.080 in) wall could potentially have 
a contour of 1.0 mm (0.040 in), 0.5 mm (0.020 in), 0.3 mm (0.013 
in) or 0.25 mm (0.010 in). So, begin by measuring the feature and 
dividing its value by even numbers (Figure 52).

Next, confirm that the desired width is available for the job’s tip size. 
For a T16 tip, the 0.5 mm (0.020 in) value is the default option. The 
available widths are visible in the dropdown menus of the toolpaths 
and custom group settings functions. 

The selected width value becomes the contour width setting in the 
next step.

4.3.3. Define toolpath settings (Figure 53).

With the custom group displayed in the Group Name dialogue box, 
select “Modify” from the custom groups pane. Change contour style 
to “Multiple contours,” which provides a userdefinable perimeter 
thickness made from one or more contours. 

Next, set the value for contour width, which was 0.5 mm (0.020 in) in 
the above example. Then, set the number of contours to two. 

The result is a feature with both an inside- and outside-contour 
thickness of 1.0 mm (0.040 in).

4.3.4. Add curves to custom group.

Select all curves that will use the new custom group and click “Add.”

4.3.5. Generate toolpaths (Figure 54).

Figure 51: Defaults may produce porosity at the point  
of turnaround.

Figure 50: Defaults may produce voids in thin walls
when rasters cannot fill between contours.

Figure 52: Measuring procedure within Insight
Software.

Steps:
1.	Display measurements  

(View > Measure data).

2.	Right click and select either 
“Snap-measure”  
or “Measure.”

3.	Left click and drag  
over feature.

Figure 53: Custom group settings for solid fills using
“Multiple contours”.

Figure 54: Result – solid fill for boss.
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The last step is to generate toolpaths, shade and view them. 
(Toolpaths > Shade toolpaths or right click > Shade toolpaths) The 
result should be solid fills with no gaps between rasters. If gaps exist, 
adjust the custom group values.

This type of custom group can also create features with an internal raster 
bounded by the user-defined “Multiple contours.” The next approach to 
improved strength is very similar but it uses the “Single contour only” style 
which can have only one contour.

Procedure:

4.3.6. Create custom group.

Follow the instructions for 4.3.1. and 4.3.2. For the latter step, divide 
the measurement by 2 only.

4.3.7. Define toolpath settings (Figure 55).

From the custom groups window, select “Modify.” Change “Contour 
style” to “Single contour only” which provides a user -definable 
perimeter thickness made from one contour. Next, set the contour 
width value to the number calculated in 4.3.6.

Note: This method will not work with a 2.0 mm (0.080 in) feature 
using a T16 tip. The necessary value (1.0 mm / 0.040 in) is not an 
option for this tip size.

4.3.8. Add curves to custom group.

Select all curves that will use the new custom group and click “Add.”

4.3.9. Generate toolpaths (Figure 56).

The last step is to generate toolpaths, shade and view them 
(Toolpaths > Shade toolpaths) or (Right click > Shade toolpaths). The 
result should be solid fills with no gaps between rasters. If gaps exist, 
adjust the custom group values.

4.4. Custom group for supports made with model material (**)

Although it takes only a few seconds per layer, the time to switch between 
model and support material can have a noticeable impact on throughput. 
The increase in build time becomes more significant as the number of 
layers increases. 

To eliminate this time from the build, create a custom group that builds 
Sparse supports from model material.

Apply this technique when the design includes a large number of 
layers with both model and support curves (“Sparse style”), and 
when the supports are accessible and easily removed. This technique 
is only applicable for layers that contain just part curves (red) and 
“SupportSparse” curves (dark gray). To determine if these conditions exist:

•	General supports

-- After slicing the file, set support style to “SMART” or “Sparse” 

Figure 55: Custom group settings for solid fills using
“Single contour only.”

Figure 56: Result – solid fill for thin walls.

Figure 57: View slices to find those with only support (gray) 
and model (red).
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(Support > Setup). Then click the “Create supports” icon.
•	View slices (Figure 57).

-- Scroll through all the slices. Look for:
•	Layers with only model (red) and “sparse/SMART” supports  

(dark gray).

•	Support curves that can easily be removed. 
 
Avoid applying this technique to supports that surround model curves 
and supports that are surrounded by model curves. With either 
condition, the supports will be difficult to remove without damage 
to the part. To swap model material for support material, use the 
following procedure:

To swap model material for support material, use the following procedure:

4.4.1 Create custom group (Toolpaths > Custom groups > New).

Click the “Templates” icon and select “SupportSparse” from the 
Template group menu (Figure 58). Click the checkmark.

By using the template, the new custom group inherits all of the 
toolpath settings from “SupportSparse.”

4.4.2. Modify toolpath settings.

The only setting that will change is “Toolpath material.” To make 
supports from model material, simply select “Model” from the 
dropdown menu (Figure 59).

Give the custom group a group name and click the checkmark to 
save it.

4.4.3. Add default support curves to custom group.

Select only the support curves (gray) that are accessible and 
removable. DO NOT add basic supports (gold) or support interface 
(green) curves.

After selecting the curves, click “Add” from the custom groups 
window (Figures 60 and 61).

Figure 58: Create custom group using a template
for SupportSparse.

Figure 59: Change Toolpath material to “Model”.

Figure 60: Select the curves for the supports that will be 
made from model (white) material.

Figure 61: Apply the custom group (green) to build supports 
from model material.
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5. KEY process considerations

5.1. Obstacle details:

Table 3 presents common obstacles with jig and fixture production and 
recommended solutions.

5.2. Resolution details:

•	Machine operation:

-- Increase throughput and efficiency by managing job scheduling 
to leverage “lights-out” operations.
-- Group parts in a single build.

•	Design for FDM:

-- Redesign tools to optimize for the FDM process: self-supporting 
angles, offset surfaces, material removal and wall thicknesses.

•	Process control:

-- Use advanced Insight software fill styles, custom groups (e.g., 
strength, porosity and build time).
-- Select appropriate slice heights.

•	Secondary processing actions:

-- For surface smoothness: mass finishing, vapor smoothing, 
secondary machining or sanding.
-- For accuracy and flatness: secondary machining.
-- For porosity: sealing or vapor smoothing.
-- Electroplating metal inserts, etc.

•	Material selection:

-- Select the best material to meet the performance requirements 

Obstacle Resolution

Machine  
Operation

Design  
for FDM

Process  
Control

Secondary  
Processes

Material  
Selection

Part  
Orientation

Build Time Excessive build times diminish value. 4 4 4 4

Porosity Internal porosity impacts performance. 4 4 4

Accuracy Dimensional accuracy does not meet operation 

specifications.
4 4 4

Surface Finish Visible layers and toolpaths  

impact performance.
4 4 4 4

Material
Cost

Higher cost than other  

manufacturing materials.
4 4

Flatness Variation in XY plane impacts performance. 4 4 4 4

Small 
Features

Resolution is too coarse to replicate. 4 4 4

Part 
Properties

Available materials do not offer properties that 

meet operational specifications.
4 4

Operating
Conditions

Demanding requirements when in service 

(e.g. mechanical loads, thermal exposure and 

chemical exposure).

4 4 4

Table 3: Common obstacles and resolutions.

Figure 62: Inspecting a yoke using an FDM fixture.

Figure 63: “Freeform” design for BMW’s bumper  
reach fixture.
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(e.g., mechanical, thermal) instead of defaulting to what is in  
the machine.

•	Part orientation:

-- Position part to improve feature accuracy, strength, surface 
finish and build time.

6. Tools & Supp lies

6.1. Required items:

•	No additional tools or supplies are required.

7. Recap - Critical Success Factors

7.1. Leverage advantages of additive manufacturing by using good  
	 FDM practices.

•	Part consolidation

•	Design freedoms

•	Flexibility to redesign

•	Automated, “lights-out” operation

•	Small lot, on-demand production

•	Lead time and cost reduction

7.2. Optimize tools for FDM.

•	Strength

•	Aesthetics

•	Ergonomics and ease of use

•	Maximum throughput/minimal time

•	Lowest piece-part cost

7.3. Eliminate adoption obstacles.

•	Modify tool for intended application.

-- Consider advanced Insight software settings.
-- Design to improve physical and mechanical performance.

•	Reduce build time and material cost (i.e., large, bulky objects).

-- Self-supporting angles
-- Substitute model material for supports.
-- Remove mass in the design or substitute with sparse fill.
-- Leverage “lights-out” operations.

•	Apply to operations where the characteristics of thermoplastics  
are suitable.

•	Improve surface characteristics.

-- Use Insight’s visible surface rasters or small slice heights.
-- Use mass finishing, vapor smoothing, secondary machining  
or sanding.

•	Improve dimensional accuracy for high-precision operations.

-- Offset surfaces in CAD.
-- Orient critical features in XY plane.
-- Use secondary machining operation.
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